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Overview 

Version 8.90 of dw-2000 contains new features and updated functionalities 
designed to enhance our customers' productivity. In this document we highlight 
the changes since the release of version 8.75. 

dw-2000 Roadmap 

It has been about 3 years since the release of version 8.75. This delay is 
appreciated by our clients as they like keeping the same stable environment and 
avoid any disruption in their design flow. As usual, over the period between 
release, Design Workshop provides features and improvement continuously 
throughout the period, without requiring a version change. 
 
As mentioned in the v8.75 release notes, Design Workshop Technologies has 
been working on two major software versions. This release is the one where we 
introduce the Direct2D technology (DirectX) which will increase Layout speed 
and add valuable editing features to increase productivity. 

Direct2D – Improved Layout Experience 

As designs become larger in layouts, loading and data display can take time. The 
added Direct2D technology in dw-2000 significantly increased the drawing 
speed and allows for richer layout editing experience. Direct2D technology 
enables access to powerful video card features to render graphics on the display 
at an amazing speed and image quality. In this release you will have the 
opportunity to see all the amazing layout aids added to provide a better user 
experience and reduce layout time. 

Data File Conversion 

New options are available for the GDSII and OASIS file conversion and some 
changes to the MEBES and AutoCAD converters. See Data Conversion section 
for further details.  
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Features And Improvements 

Direct2D 

Starting with this release, dw-2000 uses the DirectX technology from Microsoft. 
More precisely its Direct2D which is a module of DirectX. Using Direct2D, the 
time to load and display layout is significantly reduced while improving the 
rendered graphics for a better visual effect. In addition, it brought valuable tools 
to improve layout productivity as you will see in the next section. 

Improved Layout Experience 

Direct2D opens the door to a new layout experience. In addition to drawing 
speed, it offers a better color and improves color blending using partial 
transparency amongst layers. Anti-aliasing improves text readability when used 
with cursors, rulers, and layout text elements. Here is a short list of new and 
improved layout features in this release: 
 

• New element drawing 

• Path outline display 

• Automatic PUT after dragging new Circles and Ellipses 

• New Text sizing frame 

• New editor outline and features 

• New Aref shape modification features 

• New editing visuals 

• New Rotation icon 

• Holding the SHIFT key 

• New reference element content display 

• New visual for the group stretch 

• Boolean Toolbar highlights 

• Element transparency control 

• Measurement display along the ruler bars 

• New quick measurements feature 

New Element Drawing 

Replacing the solid green line, when digitizing a new element, it will now 
display the current layer color, fill, and border thickness. You know immediately 
if you are using the correct layer before putting it. This will save a few steps since 
you won’t need to select it, change its layer, and put it in again. 
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Path Outline Display 

In addition to the new element drawing, as you draw a new Path element, it now 
displays its outline showing its width, endcap style and drawing edge. Upon 
selection, the outline is also drawn so you can better see where it lands upon any 
modifications like moving, copying, stretching, rotation, reflection or adding 
segments. 
 
v8.75 Path Creation    v8.90 Path Creation 

 
v8.75 Selected Path    v8.90 Selected Path 

New Text Sizing Frame 

Upon selection, a frame is now shown around the Text element. Using the 
mouse, you can stretch any of the four sides to modify its Text size property.  
 

  
 
The new Text size is shown next to the mouse cursor. As you move with your 
mouse cursor, the Text size increases or decreases by steps matching the current 
grid scale value.  
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Automatic PUT after new Circles and Ellipses  

For consistency with dragging a rectangular boundary, when using the same 
mouse action with circles and ellipses, they are placed immediately once you 
release the mouse button, removing the need to press ENTER before creating 
another element. 

Holding the SHIFT key 

In the following topics, many editing and group commands will react when the 
SHIFT key is pressed to limit movement direction or rotation angle. 

New Editor Outline and Features 

The selected element is now displayed with a dashed contour line with new 
colored dots. The white dots are placed on top of each coordinate and the green 
dots at mid distance of each segment. The selected element will now always be 
easier to locate at any zoom level. The selected element color can be changed as 
usual via the dw-2000 preferences under the color tab. 
 
(v8.75) Using a solid green line: 

 
(v8.90) Using a dashed line with white and green dots: 
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New Aref Shape Modification Features 

Upon selecting an Aref, notice the new white and green dots. Using the mouse, 
you can drag the white dots to modify the Aref Pitch in X, Y, or both at once. The 
green ones are located on the top and the right edges corresponding to the Aref 
extent. You can stretch these two edges to modify the Aref row or column 
counts. You may stretch to the upper corner to modify both Row and column 
counts at once. 
 

 
 
White dots to change Dx & Dy   Green dots to change row & column count 
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New Editing Visuals 
The following images are some examples of the visual effects added to editing 
elements. Using the stretch edge or move vertex commands, the original and 
new locations are shown in figure 1 and 2.  
 
Edit > Stretch      Edit > Move Vertex 
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Copying and moving an element, a copy of the element follows the mouse cursor 
and a line which displays the displacement from the chosen source location to 
the current cursor location. The total displacement (dX & dY) is shown next to 
the cursor. In addition, holding the SHIFT key will snap the operation to a 
vertical, horizontal or 45 degrees from the source location.  
 
Copy or Move 
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The reflection command also draws a copy of the element showing final location 
upon completing the reflection line entry. In addition, holding the SHIFT key 
will snap the operation to a vertical, horizontal or 45 degrees from the source 
location. 
 
Reflection 

 

New Rotation Icon 

All Element kinds with rotation property (Ellipse, Text, Sref, Aref, PCref) now 
displays a rotation icon upon element selection. The Element insertion point is 
the pivot location. The rotation is made by 1 degree increment or 45 degrees 
while holding the SHIFT key. 
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New Reference Element Content Display 

The Direct2D performance increase allows us now to display the selected Sref, 
Aref or PCref element contents while dragging them around to facilitate their 
alignments with surrounding elements. If you have a computer with limited 
graphics capabilities to properly display the reference content, you can disable 
the 'Draw reference content on edit' option located under the Graphics tab in the 
preference window. 

New Visual for The Group Stretch 

The selection outline is now persistent until the stretch operation is completed. 
All vertices inside the outline are moved by the specified line displacement. 

 
Stretch selection outline    Entering translation line 

 
Stretch Result: 
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Element transparency control  

With the implementation of Direct2D, we now have access to transparency 
feature which we now apply to the layout display. You can change the settings 
via the Graphics tab in the dw-2000 preferences. This feature significantly 
enhanced the layout display especially when many layers are overlapping.  
 

 
 
As their name suggests, the fill opacity is applied to the Boundary, Path, Circle, 
and Ellipse element fills whereas the text opacity applies to text elements. For 
example, reducing the opacity value of text element reduces its visibility whereas 
if set to 100%, the text element will stand out. The opacity values all range from 
30 to 100%. 
 
The reference opacity is an interesting feature which helps distinguish the 
element from the current hierarchical level versus the ones located in sublevels. 
In the following image, we can see the effect when the reference opacity is set to 
40%. 
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Boolean Toolbar Highlights 

The element selection is now persistent until the Boolean command is cancelled 
with ESC. In the following example, we perform an OR operation between two 
shapes. The first shape selected is surrounded by a dashed contour. This contour 
is more visible and remains visible even if you zoom or pan the display. 
 

 
 

 

Measurement Display Along the Ruler Bars 

The ruler bars will now display intermediate measures along the ruler. 
 

 
 
As you zoom closely to the measured element, the measurement numbers will 
also be adapted to the current zoom level. 
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New Quick Measurements Feature 

 
The quick measurement is a new cursor mode used to display vertical and 
horizontal distances at the cursor location. As shown in the images below, as you 
move the cursor between or inside elements, two measurement lines are shown 
vertically and horizontally. The lines stop at the first visible element outlines and 
show the distances in the lower right side of the cursor. 
 
We enable or disable the quick measurement mode via the View menu or using 
the Toolbar icon shown above. The corresponding GPE command is QMeasure 
which you can use in your shortcut customization to toggle the quick 
measurements On or Off. 

Minor Change to Rotate and Reflect 

 
The rotation and reflection commands are no longer sticky and will now perform 
the operation only once. As a result, you won’t need to cancel using the ESC key 
once the operation is completed. 

  



  Features And Improvements 

Release Notes  17 

Automatic GPE Task Cleanup 

The sticky commands, such as copy and move, are now removed automatically 
from the GPE command stack if there are no more selected elements targeted by 
the pending command. As a result, you are no longer required to manually clear 
the commands using the ESC key hence reducing the confusion when there are 
several pending commands and no more candidate elements to apply it to. 

New Element Masking Toolbars 

We can now quickly toggle visibility and selection by element kinds using these 
two new toolbars. They are the equivalent of the 'Mask for Element Kind' found 
in the Masks window. 

 

New and Removed Preferences 

A few obsolete preferences were removed, and some new ones added. Here is a 
short list of the changes. 

• General: Remove obsolete preference related to boxes Layers and Types. 

• Colors: A new color swatch is available for the ruler bars.  

• Colors: Two different sets of colors are now stored, one for the white and 
one for the black background. 

• Graphics: With the new cursor position display, the text color is no 
longer required and was removed. 

• Graphics: A new preference is available to turn off reference content 
display while editing reference elements. This option will help when you 
have a computer with limited graphic capabilities. 

• Graphics: New transparency options to control opacity for polygons fills, 
Text elements and sublevel reference elements. 

• Circles: The circle approximation options no longer apply to the GDSII 
file conversion. The GDSII export now has its own option presented in 
the conversion option window. 
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Fill and Contour Color Synchronization 

In the palette window, you can now hold the SHIFT key while picking a color to 
change both contour and fill colors at once. 

 

Aref Properties 

The Aref properties window now provides a button to automatically set the Aref 
delta X and Y to match the selected reference structure dimensions. 

TPK Search Paths 

Added in one of the v8.75 updates, the dw-2000 technology files (.TPK files) are 
no longer required to be stored under the Technology folder where dw-2000 is 
installed. You can now add a GPE load path via the GPE browser window to let 
dw-2000 know where to find them. 

Retired C Developer's Kit Module 

The C Developer's kit, which was part of the Advanced GPE Extensions, has 
been retired. There were too many limitations or not enough functionality in its 
current implementation. Users now use inter process communication (IPC) to 
interface with dw-2000 which makes the C Developer's kit obsolete. 

Selection / Movement Options 

The selection and movement restrictions options, located under the Group > 
Options menu or typing WinOptions command, no longer required closing to 
apply the changes. You can now leave the window open and change any options 
which will have immediate effect in the Structure window. 

International OS & File System (Unicode) 

Version 8.90 better supports international operating and file systems (Unicode). 
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More Barcode Styles 

To complement our 2D barcodes (see QRCode and DataMatrix GPE commands), 
we have enhanced our sample Barcode PCell kit which is located under the dw-
2000 samples folder. The PCell kit now offers the following linear barcode styles: 
 

• Code 39 

• Code 39 with checksum 

• 128A 

• 128B 

PCref Coordinates 

The coordinate entry for PCref elements that requires more than one coordinates, 
such as Linear, Arc, S-Bends waveguide, is different in version 8.90 and if you 
have a GPE script that places such PCref elements, the script might not be 
compatible with v8.90 and will require minor modifications. 
 
The reason for this change was required since there were issues when PCref were 
used with rotations and would not be created correctly. 
 
If your GPE script uses the CE command to create the PCref element, no changes 
are required. When using the PutEL command, the coordinate parameter entry 
now uses offsets from origin instead of local Structure coordinates. Let's see the 
following example to describe the differences between v8.90 and earlier versions 
of dw-2000. 
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Placing a 3 coordinates Linear Waveguide using the positions (10,10) (20,20) 
(30,20) using the CE command produces the following artwork. 

 
Using the PutEL command in previous dw-2000 versions, the same local 
Structure coordinates was used: 
 
PutEl pcref,0,-2;;;;"PL_LinearWG";(10,10,20,20,30,20); ;;;;;"6;0;.025;254 0" 

 

For version 8.90 the coordinate entry with CE remains the same but for the PutEL 
command, starting with the second coordinate (in red), all entries are 
represented by an offset from the PCRef origin (in orange). 
 
PutEl pcref,0,-2;;;;"PL_LinearWG";(10,10,10,10,20,10);;;;;;"6;0;.025;254 0" 

 

Now using PutEL with the original coordinates (10,10,20,20,30,20) will not 
produce the expected result: 

 
During the transition between v8.75 and 8.90, the GPE program can be modified 
and use the correct syntax based on the current running version. We can use the 
GPE command 'version' to determine which dw-2000 is running and use the 
corresponding syntax. For example: 
 

if (nformat (version){1}) < 8.90 then 

 \ Use old syntax 

 PutEl pcref,0,-2;;;;"PL_LinearWG";(10,10,20,20,30,20);;;;;;"6;0;.025;254 0" 

else 

 \ Use new syntax 

 PutEl pcref,0,-2;;;;"PL_LinearWG";(10,10,10,10,20,10);;;;;;"6;0;.025;254 0" 

endif 
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Data Conversion (GDSII / OASIS / MEBES / AutoCAD) 

Many changes were made to the dw-2000 file conversion formats which you will 
discover below. If the file extension .GDS and .OAS are mapped to the dw-2000 
program, double clicking any of those files will start dw-2000 and open it 
corresponding conversion window. You may as well drag and drop the files over 
the dw-2000 program to start the conversion process if no structure is currently 
open. 
For complete details, the PDF manuals are found under the dw-2000 Help menu 
under Data Conversion, OASIS Conversion and AutoCAD conversion. 

AutoCAD Conversion 

This conversion module now supports AutoCAD file formats (DXF & DWG) 
used by AutoCAD software from the year 2000 to 2024. Note that Autodesk has 
been using the same file format since year 2018. 

GDSII Conversion 

There are many new features and improvements in the GDSII file conversion 
which include a new conversion option interface which displays all the options 
in one single prompt window. Starting with the common changes in both the 
import and export operations, the log file now includes all the selected 
conversion options, more detailed warnings and errors, and a detailed report 
when used with a layer mapping file. The Text Scaling option is now a 
magnification factor for both import and export. A new option lets you hand 
pick the Structure and layer names to import or export. 

GDSII Import 

Here is a list of the new import options: 

• You can now associate an installed Technology Package with the 
imported GDSII data. 

• New option to automatically "Create missing layer names". 

• A new option to "Output detailed information in the log file". Use this 
option append additional information such as the data locations to the 
various errors or warnings in the log file. 

• New GPE commands: GDSImportOptions, GDSImport 
 
The following option list were removed or changed: 

• Removed: "Put truncation error on error layer". 

• Removed: "Rebuild Hierarchy ". 

• Changed: "Don't replace structure with later creation/modification 
dates." 

• Changed: "Use Criterion" replaced by the new layer selection option. 

• Obsolete GPE command: Streamin 
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GDSII Export 

Here is a list of the new export options: 

• The circle approximation option (which includes ellipses) is now defined 
in the conversion option rather than using the one defined under the dw-
2000 preferences. 

• New GPE commands: GDSExportOptions, GDSExport 
 
The following option list were removed or changed: 

• Obsolete GPE command: Streamout 
 
The GDSII conversion manual is found under the dw-2000 Help > Data 
Conversion menu. 

OASIS Conversion 

There are many new features and improvements in the OASIS file conversion 
which include a new conversion option interface which displays all the options 
in one single prompt window. Starting with the common changes in both the 
import and export operations, the log file now includes all the selected 
conversion options, more detailed warnings and errors, and a detailed report 
when used with a layer mapping file. A new option lets you hand pick the 
Structure and layer names to import or export. The Layer mapping was added to 
the conversion options. 

OASIS Import 

Here is a list of the new import options: 

• You can now associate an installed Technology Package with the 
imported OASIS data. 

• New option to automatically "Create missing layer names". 

• New GPE commands: OASISImportOptions, OASISImport 
 
The following option list were removed or changed: 

• Removed: "Put truncation error on error layer". 

• Changed: "Use Criterion" replaced by the new layer selection option. 

• Obsolete GPE command: OASISin 

OASIS Export 

Here is a list of the new export options: 

• You can now choose to export or not the layer names defined in the 
current Library. 

• New GPE commands: GDSExportOptions, GDSExport 
 
The following option list were removed or changed: 

• Obsolete GPE command: OASISout 
 
The OASIS conversion manual is found under the dw-2000 Help > OASIS 
Conversion menu. 
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MEBES Conversion 

The MEBES export has a revised conversion option interface which removes the 
confusion with the extent option. You can now choose to use the entire data 
extent which includes the Structure extent and additional extent if a positive size 
option is used, or you can manually enter the desired extent which will be used 
to clip any data the lies outside of it. The second change is for MEBES mode V 
conversion where the minimum resolution changed from 0.005 to 0.001. 
 
The OASIS conversion manual is found under the dw-2000 Help > Data 
Conversion menu. 
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New and Enhanced GPE Commands 

We make our best efforts to maintain compatibility with the GPE program 
written for previous versions of dw-2000 and to avoid any disruption. 
Nevertheless, we recommend having a look at the following list of commands. 
Especially, the new and modified commands will enhance your current GPE 
program implementation and give you access to new functionality. We suggest 
replacing or removing any of the obsolete commands. 
 
The GPE command syntax, description and examples are available under the 
dw-2000 Help > Help menu, under the GPE command list. 

New GPE Commands 

Command Description 

ContourWidth Sets the contour line thickness for the specified layers to 
the specified width value. 

CreateLayerMatrix Takes a layer name list and returns the corresponding 
Layer/Type numerical matrix. 

CtrlKey This command has the same behavior as 'OptionKey' 
which verifies the CTRL key state during a mouse 
operation. 

DrawingOn /  
DrawingOff 

Use these commands to enable/disable element 
drawing in the opened Structures. The context in which 
these commands are used is in a GPE program which 
performs layout operations that displays layout 
changes or navigate through the layout. Temporarily 
turning off the drawing during the operations will 
allow your GPE program to run faster. 

FStruct This command finds the opened Structure index, 
ranging from 1 to 20, where the Element key resides. 

GDSExport / 
GDSExportOptions 

These commands replace 'Streamout'. 

GDSImport / 
GDSImportOptions 

These commands replace 'Streamin'. 

GetScreenInfo This function returns the screen information which 
includes the width, height, minimum X and Y 
positions, maximum X and Y positions, minimum and 
maximum window sizes, all in pixel units.  
When multiple displays are used, the values include 
the desktop extension. 

GetTPKFileNames This function returns the list of all Technology Package 
(.TPK) file names currently available in the dw-2000 
framework. 

IDSelectAll Adds all selectable Elements to the group. 

IndicesOfList Use this command to locate a list element from a list. 
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Command Description 

IsDirectoryValid This new command is used to verify if a specified 
directory exists on your file system. 

MatchWildcards Use this command to perform a string search using dw-
2000 wildcards. 

MTBoolean Use this command to run a Multithreaded Boolean 
operation. 

OASISExport / 
OASISExportOptions 

These commands replace 'OASISout'. 

OASISImport / 
OASISImportOptions 

These commands replace 'OASISin'. 

Opacity Sets the transparency level for polygon fills, Text 
Elements, and sublevel Sref and Aref elements. 

PCellsUsed This function returns a list of PCell names of all PCref 
instances placed in any of the Structures in the current 
Library. 

PCRename Use this command to rename a PCell definition. 

QMeasure Use this command to enable or disable the Quick 
measurement cursor mode. 

  

Enhanced GPE Commands 

Command Description 

CoordInput This command has a new parameter that let you choose 
what to do when the user presses the ESC key. 

Dataxxx GPE commands starting with 'Data' which modifies 
layout (DataCopy, DataMove, DataOversize, etc) now 
works with closed Structures. 

DlaCirclesToLayer Added a parameter to setup the segment count per 360 
degrees. 

DlaEllipsesToLayer Added a parameter to setup the segment count per 360 
degrees. 

DlaLayerToCoords New parameter MaxCoordPerPoly. 

Dlgxxx The Dialog module commands, starting with 'Dlg', 
have been updated in the Help and PDF manual. Their 
syntax is now clear, and many examples were added. 

IDCircleExplode Added a parameter to setup the segment count per 360 
degrees. 

PathInput This command has a new parameter that let you choose 
what to do when the user presses the ESC key. 

PolyInput This command has a new parameter that let you choose 
what to do when the user presses the ESC key. 

PutEL For PCref elements, when used with a multi-coordinate 
PCell, the coordinates number 2 and beyond are 
specified as an offset from coordinate number 1. See the 
PCref coordinates section for more details. 
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Command Description 

SavePict The command now supports TIFF file format. As a 
result, the options are BMP, GIF, JPG, PNG, and TIFF. 
The file format parameter has been removed from its 
syntax. 

WindowInput This command has a new parameter that let you choose 
what to do when the user presses the ESC key. 

 

Obsolete GPE commands 

Command Description 

Dashed, Dotted, 
Broken, Solid 

These commands were used to control the layer 
contour pattern which is now always solid for many 
years already. The only command that changes the 
contour is 'ContourWidth'. Using these commands will 
simply have no effect. No errors will be reported upon 
compiling your GPE scripts. 

Devkxxx All commands starting with 'DEVK' for the C 
Developer's kit are now disabled since the module is 
officially retired. Using these commands will simply 
have no effect. No errors will be reported upon 
compiling your GPE scripts. 

OASISin / OASISout These commands will continue to work for a while, but 
we suggest using the new commands (OASISImport, 
OASISImportOptions) to get access to the new 
converter options. 

Prefix This unused command was removed. If the command 
was used in your GPE script, an error is shown at 
compile time. 

StreamIn / StreamOut These commands will continue to work for a while, but 
we suggest using the new commands (GDSImport, 
GDSImportOptions) to get access to the new converter 
options. 
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